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Foreword
As educators we take upon ourselves the task of offering skills, knowledge, and education
to all the students entrusted to us by their parents, aiming to shape not only well-qualified
professionals and personalities with adequate background knowledge that will help them
make it later on in life but also responsible citizens that will contribute to the common
benefit of society locally, nationally, and internationally. Within this framework, we get in
daily contact with our students, we work together, we guide them through their studies,
and we encourage them to express themselves bringing out what is best in them as students
and individuals. However, we can only do that as long as our students remain under the
common roof we share and call “school”.
Sometimes, students decide or are forced to stay away from educational or training
institutions due to specific circumstances. It’s a practice society looks so unfavourably on
that we have devised the derogatory term “drop-outs” to refer to students who opt to follow
this path. Nevertheless, it’s such a widespread practice that the scientific term “early school
leaving syndrome” has also been introduced to describe and help study it. According to the
EU Education Ministers, “early school leavers [are] people aged 18-24 who have only lower
secondary education or less and are no longer in education or training. Early school leavers
are therefore those who have only achieved pre-primary, primary, lower secondary or a
short upper secondary education of less than 2 years.” (1)
The European Union has tried to tackle and control the problem of Early School Leaving
(ESL) on three different levels:
• With Strategic Level Responses,
• With Preventive Strategies, and
• With Reintegration Strategies
On the higher level of the strategic level responses, the European Labour Force Survey has
taken upon itself the burden of measuring statistically and monitoring ESL across Europe
which the European Commission coordinates policies adopted and measures taken by
the member states. Targeted approaches have also been adopted as preventive strategies.
Member states have been encouraged to target local or specific groups of people that
are at risk of ESL to achieve better and more immediate results. Mentoring or “buddy”
programmes have been proposed as a solution for students in transition from school to the
labour market. Extra tuition and/or financial support for children with learning difficulties
or underprivileged background has also been adopted by some member states. Teacher
training and curricular reforms is one of the structural responses that have been proposed
as a measure that could potentially help reduce ESL. Guidance and counselling are also
considered good practices as a means to keep students at school or facilitate their transition to
the labour market. Cooperation with parents or student guardians and the local community
is also believed to help combat ESL (2).
The introduction and implementation of Learning Management Systems (LMS) in schools
could also help keep ESL under control. As reported by the management and staff of the
International Business College in Kolding, Denmark, “School’s LMS help students at risk of
6

ESL to structure homework and has disciplinary effect on attendance” as students can access their
schoolwork through a medium they feel familiar with and get better prepared for school while
teachers can easily supervise student work and offer them immediate feedback. Furthermore,
according to the same report, ESL is encouraged by the fact that teachers spend “too much time on
technology development” instead of focusing on and meeting student needs. (3)
Using a LMS that is widely accepted as effective, robust, and secure while at the same time it is
based on open-source software and supported by a widespread, global community can help save
time on technology development while at the same time teachers and students can reap the benefits
of using a personalised learning environment. Moodle is such a learning platform that offers all of
the above and more. It is:
• used by more than 65 million people on all levels of education and entrepreneurial
context around the world
• free and simple to use
• under continual review and improvement
• available in a wide variety of languages
• customisable to suit your needs
• flexible and expandable
• backed by a strong and helpful community
• extensively documented
Most importantly, if you decide to incorporate Moodle in your teaching practice, instead of resorting
to a variety of easily available Web 2.0 resources on the internet, you get to keep your students’ data
in your own hands. You don’t share it with “free” services of dubious origin and with vaguelyworded data processing agreements.
The visual guidebook you have in your hands will hopefully allow you to scratch the surface of
Moodle. It is meant to be used in the context of a 15-hour workshop, together with a list of tasks to
be completed with the help of the facilitator in charge but you can surely benefit if you follow the
instructions with the help of the prompts and if you are not afraid to use the extensive help that is
available on all Moodle websites.
In any case, too much theory and not enough understanding is not probably the way to approach
any LMS. So, keep calm and take the plunge into Moodle.

NOTES
(1) http://ec.europa.eu/europe2020/pdf/themes/29_early_school_leaving.pdf
Accessed: 4 Jan 2015
(2) REDUCING EARLY SCHOOL LEAVING IN THE EU
GHK Consulting Ltd et. al.
Brussels, 2011.
https://www.spd.dcu.ie/site/edc/documents/ESLfinalpublishedstudy-execsum.pdf
Accessed: 5 Jan 2015
(3) ELFE-ESL: Case Study Visit Report
http://www.csee-etuce.org/images/attachments/study_report_denmark.pdf
Accessed: 20 Jun 2015

Downloading Moodle

1

2

Go to https://moodle.org/ and click Download.

Click on Moodle 2.9+ in the center of the page (or the Latest
release under the Standard Moodle heading).

8

Downloading Moodle

3

Click Download zip (or Download tgz, whichever you
prefer) in the MOODLE_29_STABLE line.

4

Your download should begin in a couple of seconds. If not,
click on the link indicated to download manually.
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Using cPanel to Set up Moodle

1

2

Go to your website’s cPanel home page and click on File Manager.

Select Web Root to go to your website’s root folder and click Go.

10

Using cPanel to Set up Moodle

3

Your root folder should be empty or contain only a minimal
number of folders and/or files. Click the Upload button.

4

Click Browse... and select the Moodle file you have just downloaded to
upload on your website. The upload should start automatically. Once
completed, click on the Go back link to return to your root folder.

11

Using cPanel to Set up Moodle

5

Right click on the file you have just uploaded and select Extract.

6

When the extraction process is completed, you will see that a moodle
folder has been created. Right click on the file you have uploaded and
select Delete to remove it. Then, double click on the moodle folder.

12

Using cPanel to Set up Moodle

7

Once in the moodle folder, click Select All, right click anywhere on the
files selected, and click Move. In the popup window that appears,
delete /moodle and click Move File(s). Then, click Up One Level.

8

Once you’ve moved back to your root folder, right click
on the moodle folder and select Delete to remove it.
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Using cPanel to Set up Moodle

9

10

Click on your home folder and, then, on New Folder to create a new
directory. It is Moodle’s data folder where any files you upload for your
students will be stored. Use any name you like (e.g. moodledata).

Right click on the folder you have just created and select Change Permissions.
Activate all the checkboxes and click on the Change Permissions button.

14

Using cPanel to Set up Moodle

11

Note down the path to your home folder, adding the name of
Moodle’s data folder to it, e.g. /home/myhome/moodledata. It is
the full path to Moodle’s data folder. We’ll need it later on.

12

Go to your website’s cPanel home page and click on MySQL Databases.
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Using cPanel to Set up Moodle

13

Type in the name of the database you would like Moodle to use, e.g.
moodledb. Note down the database prefix and the name you have
typed in (e.g. mysite_moodledb) and click on Create Database.

14

Type in the name of the user you would like Moodle to use, e.g. moodleusr,
and a strong password. Note down the password, the database prefix, and the
name you have typed in (e.g. mysite_moodleusr) and click on Create a User.
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Using cPanel to Set up Moodle

15

Add the user your have created to the database you have
created by selecting them and clicking Add.

16

Activate All Privileges by clicking the All Privileges
checkbox and, then, Make Changes.
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Installing Moodle

1

2

Go to your browser and type in the URL of your website. You should
see the following installation page. Select the language you prefer to use
during installation (for the time being, stick with English) and click Next.

Your website’s Web Address, Moodle directory, and Data directory should now
appear. If the Data directory is not the same as the path you noted down in Step
11 of Using cPanel to Set up Moodle on page 15, correct it! Then, click Next.
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Installing Moodle

3

Select the type of database you are going to use. Choose Improved MySQL
if you have followed these instructions so far. Then, click Next.

4

Fill in the database name, the database user, and the database
password you noted down in Steps 13-14 of Using cPanel
to Set up Moodle on page 16. Then, click Next.

19

Installing Moodle

5

Read the Moodle License information page and, if you agree to
the terms of their license agreement, click Continue.

6

Moodle will check a few things on your server and make suggestions or
report problems. You should take action to fix any problems reported
but, most of the times, you simply need to to click Continue.
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Installing Moodle

7

Moodle with then report on a number of plugins that have
been installed. If any problems are reported, you probably
need to fix them. Otherwise, click Continue.

8

Moodle will then ask you to complete the details of your website administrator.
Make sure to note down the username and password you enter or you will
not be able to access your website. When you are done, click Update profile.

21

Installing Moodle

9

10

You then need to fill in a few details about your website. You
can change everything later on. So, don’t worry if you make
a mistake. When you are done, click Save changes.

You are now ready to start working on your website!

22

Logging in

1

2

Go to your browser and type in the URL of your website. Then,
click on the Log in link at the top right-hand corner.

Type in your administration credentials (username
and password) and click Log in.

23

Getting Help

1

2

To get quick tips, you can click on the question mark icon wherever it is
available. A pop-up window will appear and give you a quick tip.

If you need extensive information on the page you are browsing, just go
to the bottom of the page and click on Moodle Docs for this page. You will
be transferred to the relevant Moodle documentation website for help.
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Customizing Your Preferences

1

2

Once you have logged in, click on your name at the
top right-hand corner and select Preferences.

You can follow any of the links that appear under the User account heading to
edit your profile, change your password, switch to a different language, etc.
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Uploading a User Picture

1

2

Go to the User picture section of your Edit Profile page.
Choose a picture you like and drag and drop it on the space
provided. You can add a Picture description if you like.

Click Update profile at the bottom of the page. Your new
picture will now appear next to your name.
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Changing Theme

1

2

Follow the path Site administration > Appearance > Themes > Theme selector.

You can change the look of your website for different types of
devices on this page. If you click Change theme, you’ll notice there are
only a couple of choices for the time being. Let’s change that!
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Adding Themes

1

Follow the path Site administration > Plugins > Install plugins.

2

Click on the Install plugins from the Moodle plugins directory.
You will be transferred to the Moodle Plugins website.

28

Adding Themes

3

Click on the Browse plugins button.

4

Make sure the Your Moodle version drop down menu displays the correct
version for your website. Then, click on the Themes link below.

29

Adding Themes

5

A list of available themes is displayed. The ones that are most suitable for
your Moodle version are marked as displayed below. It’s best to choose
one of them for maximum compatibility. Click on any theme you like!

6

Study the characteristics of the theme you have selected, read the
installation instructions or the user manual that comes with it, and click on
the Download button when you are satisfied with what you have read.
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Adding Themes

7

Return to the Plugin installer on your website as described
in Step 2 of Adding Themes page 28. Drag and drop the file
you have downloaded onto the space provided.

8

Once the file has completed uploading, click on
the Install plugin from the ZIP file button.
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Adding Themes

9

10

The theme package will be validated and the result of the process will
be displayed. If you are satisfied, click on the Install plugin! button.

Once the theme has been installed, you need to get your database up to
date. Just, click on the Upgrade Moodle database now button, the process will
be completed, click Continue, and you’ll be able to use your new theme.
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Customizing Your Theme

1

Different themes offer different options and features. For now, we will stick
with Moodle’s default theme. Follow the path Site administration > Appearance
> Themes > Theme selector and make sure Clean is your current default theme.

2

Moodle’s Clean theme offers limited customization but, still, you
can drag and drop an image file to be displayed as a site logo in the
header or add a couple of lines to appear in the footer. Try it out!

33

Customizing Your Theme

3

While testing out themes, it is a good idea to enable the Theme designer
mode. Follow the path Site administration > Appearance > Themes > Theme
settings and activate the Theme designer mode. Don’t forget to Save changes.

4

Download more themes and check out all the cool features and flexibility
they offer to help you tailor your site to your heart’s content. Once
you are done, remember to deactivate the Theme designer mode.
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Adding a Course Category

1

Moodle allows you to offer courses to your students but they have
to fall in different categories. Follow the path Site administration
> Courses > Add a category to create a course category.

2

Choose if the category you are about to create is a subcategory to
another course category, give it a name, and add a description if you
like. When you are done, click on the Create category button.
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Managing Course Categories

1

Follow the path Site administration > Courses > Manage courses and categories
to manage the course categories you have created or create more.

2

Under the Course categories heading, you can create a new course category, (un)
hide categories (eye symbol), reorder categories (arrows), or edit categories
(cogwheel). You can also turn categories into subcategories by moving them.

36

Managing Course Default Settings

1

Before creating any courses, have a look at the Course default settings.
Follow the path Site administration > Courses > Course default settings.

2

Go through the list but, for now, only change the Completion
tracking setting to Yes to be able to set course completion conditions.
When you are done, click on the Save changes button.
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Creating Courses

1

Follow the path Site administration > Courses > Manage
courses and categories to create a new course.

2

In the General slide fill in the full and short name of the course, the course
category it will belong to, whether it should be visible and when, and
erase the Course ID number (unless you have a course ID system).

38

Creating Courses

3

In the Description slide type in a short description of your
course and drag and drop any files that are relevant to your
course (e.g. course outline, course requirements, etc).

4

In the Course format slide select what type of course you would like to
create (for the time being, select Topics format), how many sections it should
have, how to treat hidden sections, and how many pages it should have.

39

Creating Courses

5

In the Appearance slide decide if you want a specific language to be enforced,
if the latest news should be displayed, if students will have access to a
gradebook for this course, and an activity report should be made available.

6

In the Files and uploads slide select the size of files you would like to allow
your students to upload on your website. Usually, 2MB would be more
than enough but you have to consider your own needs before deciding.

40

Creating Courses

7

In the Guest access slide decide if you want your course to be freely available to
your non-registered website visitors. If you feel like it, you can set a password
to allow only guests that know the password to access your content.

8

In the Groups slide select what type of groups you would like to have in your
course. Usually, Separate groups is a good choice but you can change it for
each activity you create (unless you choose to enable Force group mode).

41

Creating Courses

9

10

In the Role renaming slide you can rename some or all of the roles in your
course. For example, instead of “Teacher” you might be a “Facilitator” or
“Coach” and your “Students” might be “Candidates”, “Participants”, etc.

Finally, click on the Save and return button if you want to add more courses
or the Save and display button if you want to work further on your course.
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Adding a Teacher to a Course

1

Each course needs a teacher to manage it. Follow the path
Navigation > Courses > My courses > My course (or whatever you
have called the course category and course you have created).

2

Follow the path Administration > Course administration > Users > Enrolled users.

43

Adding a Teacher to a Course

3

Click the Enrol users button.

4

Select Teacher in the Assign roles drop-down menu and click the Enrol button
next to your name. When you are done, click the Finish enrolling users button.
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Managing Sections

1

Each course consists of sections. Let’s see how you can manage them.
Follow the path Navigation > Courses > My courses > My course (or whatever
you have called the course category and course you have created).

2

Every time you need to work on your course, click the Turn
editing on button at the top right-hand corner of the page.

45

Managing Sections

3

There is a General section at the top of the page, which you cannot
remove, and all other sections you add follow below. Use the former
for general information and/or activities about the course.

4

To add more sections click on the + button at the bottom right-hand corner.
To remove the last section you have added, click on the - button.

46

Managing Sections

5

To reorder the sections, drag and drop them by clicking on the
arrow cross at the top left-hand corner of each topic.

6

To highlight a section, click on the bulb symbol. To (un)hide a section,
click on the eye symbol. To remove a section, click on the X symbol.

47

Managing Sections

7

To edit a section, click on the cogwheel symbol.

8

You can give each section a name of your liking or let Moodle handle
the naming scheme automatically. You can also add a short description
that will be displayed within the section you are editing.
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Adding Activities or Resources

1

The easiest way to add material to your course for your students to study is to
simply drag and drop the file you want to share onto any one of the sections
you have created. To change the filename, just click the pen symbol next to it.

2

Moodle offers a variety of activities to choose from and include
in your course. Click on Add an activity or resource to see a pop-up
window with all the activities that are available on your system.

49

Adding Activities or Resources

3

When you are done going through the list, click on Assignment
and then Add. Through assignments, you can assign tasks, collect
work, and provide grades and feedback to your students.

4

When creating an assignment, give it a name and a description (usually, what
students need to do), decide if the description will be displayed on the course
page, and provide any other files you need to make available to your students.

50

Adding Activities or Resources

5

In the Availability slide decide if you want to set a deadline for the completion
of the assignment, if there is going to be a cut-off date after which extensions
should be granted, and if the assignment will be visible permanently or not.

6

In the Submission types slide decide if your students will be allowed
to type their reply online (with or without a word limit) or submit
one or more files and what the size the files ought to be.

51

Adding Activities or Resources

7

In the Feedback types slide decide if you will be able to provide feedback in a
file or through online comments, if your student’s reply will be quoted for
you to comment on, and if you intend to use an offline grading worksheet.

8

Many more options are available in the slides that follow. Go through them
and click on the help signs if an option seems obscure. When you are done,
click Save and return to course or Save and display to see the assignment.
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Adding Activities or Resources

9

10

Another type of activity you should familiarize yourselves with is the
Lesson activity. It can be used to create a linear set of content pages or
instructional activities that offer a variety of paths or options for the learner.

First of all, in the General slide give your Lesson a Name and a short Description.
Then, decide if you want the description to be displayed on the course page.
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Adding Activities or Resources

11

In the Appearance slide drag and drop a file with instructions about the lesson
onto the File pop-up area if you like. A few more options are available here.
Make sure you check out Display menu and Minimum grade to display menu.

12

In the Availability slide decide if you want to set a deadline for
the completion of the assignment. You can also set a time limit
and a password to limit accessibility to your lesson.
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Adding Activities or Resources

13

In the Flow control slide you can control if students can navigate the lesson
again, if they are allowed to try answering a question again when they
make a mistake, and how Moodle will respond to wrong answers.

14

In the Grade slide you need to decide if you want the Lesson
to be graded, what kind of grade will be given, and if
students can attempt the lesson more than once.

55

Adding Activities or Resources

15

In the Common module settings slide you need to decide if the Lesson will
be visible and if students are going to work in groups or otherwise.

16

When you are done, click Save and return to course
or Save and display to see the lesson.
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Adding Activities or Resources

17

The Book is a simple type of resource you can add to your course to
provide your students with material to study in the form of chapters
and subchapters. You can also use it to show off your students’ work.

18

In the Appearance slide decide on the chapter formatting you prefer, what kind
of navigation you prefer, and if you intend to use Custom titles. When you
are done, click Save and return to course or Save and display to see the lesson.

57

Adding Activities or Resources

19

The File is another simple type of resource you can add to your
course to offer your students a file to download. If the file can
be displayed online, Moodle will attempt to do so.

20

In the Appearance slide decide how Moodle will attempt to
present the file to your students. When you are done, click Save
and return to course or Save and display to see the lesson.
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Adding Activities or Resources

21

The Folder is a resource that allows you to display a number of related files
together. You can drag and drop a zipped file to create a folder automatically.

22

The Label allows you to display text or multimedia anywhere you want on your
course page. You can use it to embellish your course page, add instructions or
explanations, or even include some funny pictures for your students to enjoy.
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Adding Activities or Resources

23

The Page is a resource that allows you to offer your students a simple webpage
with any type of information you prefer. You can view it as a singe page out
of a Book. It is simple to handle but for longer texts, Book should be preferred.

24

The URL allows you to refer your students to online resources that are
available elsewhere on the internet. If you are in control of the referred
site, you can pass student or other information to process automatically.
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Building a Lesson

1

Once you have created a Lesson you need to add content and
practice questions for your students. You can do this from the
course page by clicking on the Edit button next to your lesson.

2

You will be taken directly to the Lesson’s editing page where you can add
content and questions. However, there are other tabs that allow you to
preview your lesson as well as get reports on and grade your students’ work.

61

Building a Lesson

3

You can also import questions you have prepared outside Moodle, add
content or question pages, or create a number of associated questions that
will be presented randomly, called a cluster. Click on Import questions next.

4

You can create questions in many ways and then import them into a Lesson by
dragging and dropping a text file onto the space provide. You can find more
information at https://docs.moodle.org/29/en/Import_questions if you want.

62

Building a Lesson

5

Adding a content page allows you to create content for your students to study.
You can give each page a title and include text and multimedia in the page
contents. Then, decide how your want to display the navigation buttons.

6

You also need to add at least one button to navigate students out of the
current page when they are done studying it. The Description will appear
as a button while Jump is the page where students will be redirected.

63

Building a Lesson

7

Adding a question page allows you to select from a variety
of question types to test your students’ understanding of
content or allow them to practice what they have learnt.

8

If you select Essay, you can ask students to write a long answer to a
topic of your choice, which you can later on grade manually.

64

Building a Lesson

9

10

If you select Matching, you can ask students to match questions to answers,
the first half of sentences to the second half, etc. You first need to give
your question page a title and type in instructions, some theory, etc.

If you want, you can type in how Moodle will respond to a correct or
wrong answer and where students should be taken afterwards.
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Building a Lesson

11

You then need to fill in at least two matching pairs to complete the exercise.
The pairs will be mixed randomly when presented to the students.

12

If you need to fill in more matching pairs, you can increase the value
of the Maximum number of answers variable in your Lesson settings.

66

Building a Lesson

13

If you select Multichoice, you can ask students to answer a multiple
choice question. You first need to give your question page a title and
type it in. You can also decide if students can select multiple answers.

14

You then need to fill in at least two choices to complete the
exercise. You can also fill in Moodle’s response to each choice
and where students should be taken afterwards.

67

Building a Lesson

15

If you select Numerical, you can ask students to provide
a number as the answer to your question. You first need
to give your question page a title and type it in.

16

You then need to fill in at least one number or range of numbers (use : instead
of -, e.g. 10:12 means all numbers from 10-12) to complete the exercise. You can
also fill in Moodle’s response and where students should be taken afterwards.
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Building a Lesson

17

If you select Short answer, students must provide a word or a short phrase
as the answer to your question. You first need to give your question page a
title and type it in. Regular expressions can be used to evaluate an answer.

18

You then need to fill in at least one response (or regular
expression) to complete the exercise. You can also fill in Moodle’s
response and where students should be taken afterwards.
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Building a Lesson

19

If you select True/false, students must decide if a statement is true or
false. You first need to give your question page a title and type it in.

20

You then need to fill in the correct and the wrong response (usually,
True and False) to complete the exercise. You can also fill in Moodle’s
response and where students should be taken afterwards.
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Building a Lesson

21

Adding a cluster allows you to create associated sets of
content and question pages that can be presented randomly.
You can also create a cluster within a cluster!

22

Don’t forget to end all the clusters that you have started.
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Adding Multimedia

1

You can add multimedia through the editor form, which
is available in all of the activities and resources you can
use in Moodle. Create a Label to check it out.

2

Click on the icon shown below to upload an image.
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Adding Multimedia

3

If you simply want to use an image that is freely available on the web
without uploading it on your website, just type its URL in the input field.
You should always add an image description for accessibility purposes.

4

If you click on Browse repositories..., you can upload a picture that is available on
your computer by clicking the Browse... button. You can upload the file using a
different name and change the license under which it is published if you wish.
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Adding Multimedia

5

If click on Embedded files, you can reuse files you use elsewhere in your Label.
Through Server files, you can use files you have uploaded on your server.
Recent files let you use files you have accessed or uploaded recently.

6

If click on URL downloader, you can download files directly from the internet.
Through Private files, you can use files you have uploaded on your private
Moodle folder. Wikimedia lets you search for files on wikimedia.org.
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Adding Multimedia

7

Click on the icon shown below to upload a video or audio file.

8

If you simply want to use a video or audio file that is freely available
on the web without uploading it on your website, just type its URL
in the input box. Don’t forget to give it a descriptive name.
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Adding Multimedia

9

10

If you click on Browse repositories..., you get a pop-up
window that more or less offers you a list of similar options
to upload video and audio files as with image files.

However, there is a specific option that allows you to search for videos
on youtube.com, which you can then embed directly in your course.
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Adding Multimedia

11

Click on the icon shown below to upload other types
of files (presentations, documents, etc).

12

You can use the drag and drop area provided to upload your files or
use this window to manage files you have already uploaded.
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Preparing for User Registration

1

Now that you have content, you need students to register as users.
However, you need to make some decisions first. Go to Administration >
Site administration > Plugins > Authentication > Manage authentication.

2

Go to the Common settings and decide if you want to allow Self registration.
Disabling Self registration means more work for you but your site is
safer from spammers. Let’s keep it disabled for the time being.
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Preparing for User Registration

3

You also need to decide if you are going to allow guest access to your
website. Guest access is useful if you want to password protect certain
courses and then share the passwords with specific visitors.

4

You can type in Instructions for your visitors to read on the login page
(e.g. you could ask them to contact you if they want to get an account).
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Preparing for User Registration

5

Go to Administration > Site administration > Security > Site policies.

6

There is a number of options here that can modify your site policy on
passwords. You can increase site security by making passwords difficult
to crack but they might be difficult for students to remember.
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Registering Users

1

Go to Administration > Site administration > Users > Accounts
> Add a new user to create a new user account.

2

You can type in the user details to create a new account on this page.
Make sure to note down the Username and Password to forward to the
new user. When you are done, click on the Create user button.
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Registering Users

3

Adding users one at a time is cumbersome if you need to add more than
a couple of users. Run LibreOffice Calc and create a file with the fields you
see below. Fill in the basic details for the users you need to register.

4

When you are done, select File > Save As... and then select Text
CSV (.csv) from the dropdown menu. Click on the Save button
and then Use Text CSV Format button in the popup window.
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Registering Users

5

Select Unicode (UTF-8) as the Character set and make sure the comma is
set as the Field delimiter. When you are done, click the OK button.

6

Go to Administration > Site administration > Users > Accounts
> Upload users to bulk create user accounts.
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Registering Users

7

Drag and drop the CSV file you have created on the space provided.
Make sure the CSV delimiter is the comma and the Encoding is UTF8. When you are done, click on the Upload users button.

8

If everything is OK, you should see a preview of the data to be
imported and the details of the user accounts to be created.
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Registering Users

9

10

Check the settings and change any values you deem
necessary. Pay special atttention to the Upload type field, Force
password change, and Prevent email address duplicates.

Fill in any Default values you would like the new user accounts to have.
When you are done click on the Upload users button. You should then see
the Upload users results. Check for any problems and click Continue.
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Managing Users

1

Go to Administration > Site administration > Users > Accounts >
Browse list of users to manage the users that have registered with
your site. You can delete, suspend, or edit any user account.

2

Go to Administration > Site administration > Users > Accounts > Bulk user
actions to bulk send a message to users, force password change, etc. Check the
With selected users... dropdown menu to see what actions are available.

86

Enrolling Users Manually

1

Now that you have registered users on your site, you can
enrol them in your courses. Go to your course and then to
Administration > Course administration > Users > Enrolled users.

2

Click Enrol users to enrol users on your course.
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Enrolling Users Manually

3

Choose the user role from the Assign roles dropdown menu (usually, Student)
and click the Enrol button next to the name of each student you want to
enrol. When you are done, click the Finish enrolling students button.

4

This is also the page through which you can manage your enrolled users. You
can unenrol students, edit their enrolment status, or assign new roles to them.
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Enrolling Users Manually

5

If you decide to assign a new role to a user, you might upgrade
or downgrade him/her to Manager, Teacher, Non-editing teacher, or
Student. You might also assign two or more roles to him/her.

6

If you decide to edit the enrolment status of a user, you can set a date for
the enrolment to start or end or even suspend the user temporarily.
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Self Enrolment

1

Manual enrolment can be a tedious task if you have a lot of courses or many
students. You can activate Self enrolment instead to make things easier. Go
to Administration > Course administration > Users > Enrolment methods.

2

Click on the eye symbol to enable Self enrolment. Then, click on the
cogwheel symbol to the Self enrolment settings for this course.
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Self Enrolment

3

On the Self enrolment settings page you should set an
Enrolment key that students can use to self enrol. Make sure
the Default assigned role is also set to Student.

4

You can also set a period of time during which enrolment is
allowed, the maximun number of students that can enrol, or a
Custom welcome message to be sent to students when they enrol.
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Bulk Enrol Users

1

If you have a lot of users and you need to bulk enrol them quickly, there is an
easier method to do that. Go to Administration > Course administration > Users
> Enrolment methods and click on the user symbol next to Manual enrolments.

2

Select the Not enrolled users you would like to enrol and click on the
Add button. The users have now been enrolled on your course.
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Question Bank Categories

1

Moodle allows you to write and organize questions that you can then
use in quizzes and lessons. Go to your course and the follow the path
Administration > Course administration > Question bank > Categories.

2

You can organize your questions in categories on three levels: i) course level,
ii) course category level, and iii) system level. Clicking on the cogwheel
symbol you can change the name or description of each question category.
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Question Bank Categories

3

You can add as many categories or subcategories as you wish.
Make sure you select the correct Parent category, give your
category a Name, and add a discription if you prefer.

4

Once you have created your first category, you can delete,
edit, change context, move up, move down, or turn a
category into another category’s child or parent.
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Adding Questions

1

Go to your course and the follow the path Administration >
Course administration > Question bank > Questions.

2

Click on the dropdown menu to select which question
category you would like your new questions to belong to
and then click on the Create a new question... button.
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Adding Questions

3

You will be presented with a list of question types you can use.
Select Embedded answers (Cloze) and click on the Add button.

4

Select the Category your cloze questions will belong to, give it a name,
type in the Question text, and give your students some General feedback if
you feel like it. When you are done, click on the Save changes button.
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Adding Questions

5

Your question will appear in the question category you have selected.
You can modify it, duplicate it, check a preview, or delete it.

6

In the preview window you can click on the Fill in correct responses
button to make sure everything works as expected.
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Adding Questions

7

To get students to write a small paragraph or a sentence,
select Essay and click on the Add button.

8

In the General slide you need to assign your question to a Category, give it
a name, and describe what your students are expected to accomplish. The
General feedback will be shown to all students if you decide to complete it.
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Adding Questions

9

10

In the Response Options and Response Template slides you can set what kind of
response your students will provide (text only, file attachments, etc). You can
also give them a template to follow (e.g. if they need to type in a report).

If somebody else will be grading the essay, you can provide
information for the grader in the Grader Information slide.
When you are done click on the Save changes button.
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Adding Questions

11

To get students to do a matching exercise, select
Matching and click on the Add button.

12

In the General slide, assign your question to a Category, give it a name,
describe what your students should do, and give them some General feedback
if you want. Enable Shuffle if you want the answers to be shuffled.
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Adding Questions

13

In the Answers slide, fill in the two halves they need to match (questionsanswers, first half-second half of a sentence etc). If you need to work with
more than three pairs, click on the Blanks for 3 more questions button.

14

In the Combined feedback and Multiple tries slides you can determine the
feedback students will receive and how Moodle should treat multiple attempts
of the same question. When you are done, click on the Save changes button.
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Adding Questions

15

To create a multiple choice question, select Multiple
choice and click on the Add button.

16

In the General slide you can determine if One or multiple answers are allowed,
the choices will be shuffled, and how the choices will be numbered.
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Adding Questions

17

In the Answers slide you can fill in as many choices as you like by clicking
on the Blanks for 3 more choices button. You can also decide what the grade
should be for each choice and what feedback students should receive.

18

In the Combined feedback and Multiple tries slides you can determine the
feedback students will receive and how Moodle should treat multiple attempts
of the same question. When you are done, click on the Save changes button.
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Adding Questions

19

To get students to answer a question with a short phrase
or one word to be compared to a predefined set of possible
answers, select Short answer and click on the Add button.

20

In the General slide, decide if the answers will be case sensitive and follow the
instructions on completing the Answers slide that follows. Visit the help pages
to learn about wildcards. When you are done, click on the Save changes button.
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Adding Questions

21

Once you have created enough Short answers, you can select Random shortanswer matching and click on the Add button to create a matching question with
randomly selected short answers from the category the question belongs to.

22

In the General slide, make sure you decide if Short answers from
subcategories will be included and how many questions should be
selected. When you are done, click on the Save changes button.
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Adding Questions

23

To create a true/false question, select True/False and click on the Add button.

24

In the General slide, select which answer is correct and fill in
the feedback students will receive depeding on their answer.
When you are done, click on the Save changes button.
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Adding Questions

25

Description is not a question but it is useful if you want to add a comment,
image, or multimedia file in your quiz. You might even want students to reflect
on something before receiving feedback. Click on the Add button to use it.

26

In the General slide, fill in the text or upload the file your students
need to study as well as any feedback you want to provide.
When you are done, click on the Save changes button.
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Adding Question Types

1

If you are not satisfied with the question types that are available by
default in Moodle, you might want to install your favorites. Follow the
path Administration > Site administration > Plugins > Install plugins.

2

Click on the Install plugins from the Moodle plugins directory
button to be transferred to the Moodle plugins directory.
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Adding Question Types

3

Click on the Browse plugins button to search for your favorite plugin.

4

Make sure your Moodle version is selected, type in “drag
and drop”, and click on the Search plugins button.
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Adding Question Types

5

Click on the Drag and drop into text link to get to the plugin description page.

6

Read about the plugin and, if you decide to install it, click on
the Download button. Save the file and go back to Administration
> Site administration > Plugins > Install plugins.
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Adding Question Types

7

Drag and drop the file you have downloaded onto the space
provided. Then, click on the Install plugin from the ZIP file button.

8

Once the plugin package has been validated, click
on the Install plugin! button to install it.
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Adding Question Types

9

10

If everything goes well, you should click on the Upgrade Moode database now.

Dependencies should fail and you should now receive an error message
as an extra package needs to be installed first. Click on the Install
link, download the plugin needed, and follow steps 6-9 again.
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Adding Question Types

11

Both plugins should now be installed. Click on the
Continue button to complete the process.

12

You should now have a new Drag and drop into text question type.
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Creating a Quiz

1

Once you have created a few questions, you might want to create a
short quiz for your students. Go to your course, click on the Add an
activity or resource link, select Quiz, and then click on the Add button.

2

In the General slide, give your quiz a name and a short description.
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Creating a Quiz

3

In the Timing slide, decide if you are going to set a deadline for your
students to do the quiz and what should happen When time expires.

4

In the Grade slide, decide what the Grading method and Grade
to pass are going to be and how many attempts students
will be given to complete the quiz successfully.
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Creating a Quiz

5

In the Layout slide, decide how many questions will appear per
page and how student will be able to navigate your quiz.

6

In the Question behavior slide, make sure you select Yes for the Shuffle within
questions setting if you want to make use of the shuffling option that is
available in certain question types and decide how Moodle will offer feedback.
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Creating a Quiz

7

In the Review options slide, tick whatever you want to make
available to your students at specific stages of the quiz.

8

The next slides, offer options to control the appearance, some extra
restrictions, and the feedback offered by the quiz. When you are
done, click on the Save and return to course button to save the quiz.
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Managing a Quiz

1

Go to your course and click on the quiz you want to manage.

2

Follow the path Administration > Quiz administration
> Edit quiz to start managing your quiz.
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Managing a Quiz

3

Your quiz is still empty. Click on Add + from
question bank to start adding questions.

4

Select the category you want to import questions from, decide if
you want to include subcategories, tick the questions you want to
import, and click on the Add selected questions to the quiz button.
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Managing a Quiz

5

The questions have been added to your quiz. However,
notice that each question is on a separate page. Click on
the Repaginate button to manage pagination.

6

Select the number of question you want per page and click on the Go button.
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Managing a Quiz

7

Your quiz is properly paginated now. You might want to add a page
break though, a new page at the beginning or the end of the quiz,
preview or delete a question, or fix the Maximum grade if it is wrong.

8

When you are done, you can follow the path Administration > Quiz
administration > Preview to see what your quiz looks like.
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Exchanging Messages

1

Moodle allows you to contant your students through private or bulk messages.
Go to your course and click on the Participants link in the Navigation menu.

2

Click the checkboxes next to the names of the participants you
want to send a bulk message to or click on the Select all button
and then select Send a message from the dropdown menu.
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Exchanging Messages

3

Type in your message in the Message body and Remove any of the recipients
if you have changed your mind. Then, click on the Preview button.

4

If you are satisfied with what you see, click on the Send
message button and you message will be sent. The recipient
should also receive a notification in his e-mail inbox.
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Exchanging Messages

5

If you want to send a private message to a single user only, go to your
course and click on the Participants link in the Navigation menu. Then,
click on the name of the participant you want to send a message to.

6

Click on the Message button, type in your message, and click
on the Send message button to send your message.
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Exchanging Messages

7

To read and reply to any pending messages you might have, click on your
user avatar at the top right-hand corner of any page and select Messages.

8

Here you can search for users to send messages to or click on
the names of users that have sent you messages to reply.
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Online Chatting

1

Moodle allows teachers and students to interact online with each
other through its chatting feature. Go to your course, click on Add an
activity or resource, select the Chat activitiy, and then click Add.

2

In the General slide, give a Name to your chat room and a short Description
of what students are allowed or encouraged to do while chatting in this
room. Decide if the Description should be displayed on the course page.
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Online Chatting

3

In the Chat sessions slide, select a date and time for your students to
chat, decide if it is a one-off, daily or weekly event, if the messages
exchanged should be saved, and if they will be publicly available.

4

In the Common modules settings slide, decide if students will participate
in groups and if the chat room should be made visible. When
you are done, click on the Save and return to course button.
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Forums

1

Moodle allows teachers and students to interact with each other
through forums. Go to your course, click on Add an activity or
resource, select the Forum activitiy, and then click Add.

2

In the General slide, give a Name to your forum and a short Description of
what students are allowed or encouraged to do while posting messages.
Decide if the Description should be displayed on the course page.

128

Forums

3

Pay special attention to the forum type you need to select. Most of
the times Standard forum displayed in a blog-like format or Standard
forum for general use can meet your needs but not always.

4

In the Attachments and word count slide, set some limits to the size
and number of the attachments users can post. This is especially
useful if you are pressed for space on your server.
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Forums

5

In the Subscription and tracking slide, if users should be forced to subscribe
to this forum and if they will be able to track read and unread posts.

6

In the Post threshold for blocking slide, you can set a policy to
block excessive messaging/spamming by the users.

130

Forums

7

In the Grade slide, you can set a passing grade for
students if this activity is to be assessed.

8

In the Ratings slide, you can set a policy on rating user messages. You
can only decide who will be able to rate posts once your forum has been
created. When you are done, click on the Save and return to course button.
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Wikis

1

Moodle allows teachers and students to add and edit a collection
of web pages collaboratively. Go to your course, click on Add an
activity or resource, select the Wiki activitiy, and then click Add.

2

In the General slide, give a Name to your forum and a short Description of what
students are allowed or encouraged to do on their wiki. Decide if students need
to cooperate or work individually and give a title to the first page of the wiki.
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Wikis

3

In the Format slide, you need to decide on the format of the wiki, i.e. what
kind of markup language will be used to edit it and if users will be able to
change that for themselves. HTML is the most straightforward format.

4

In the Common modules settings slide, decide if students will
participate in groups and if the wiki should be made visible. When
you are done, click on the Save and return to course button.
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Glossaries

1

Moodle allows teachers and students to collect and manage data
collaboratively. Go to your course, click on Add an activity or
resource, select the Glossary activitiy, and then click Add.

2

In the General slide, decide if your glossary is going to be a site-wide (global)
glossary, the main glossary of your course, or a secondary glossary.
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Glossaries

3

In the Entries slide, decide if all entries should be approved by the
teacher, if they are editable, if duplicate entries and/or comments are
allowed, and if entries will be automatically linked to other glossaries.

4

In the Appearance slide, decide on your glossary’s Display format, its
pagination and navigation links, and if a printable version will be available.
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Glossaries

5

In the Grade slide, you can set a passing grade for
students if this activity is to be assessed.

6

In the Ratings slide, you can set a policy on rating user entries. You can
only decide who will be able to rate entries once your glossary has been
created. When you are done, click on the Save and return to course button.
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Databases

1

Moodle allows teachers and students to create, maintain, and search
a collection of entries. Go to your course, click on Add an activity
or resource, select the Database activitiy, and then click Add.

2

In the General slide, give a Name to your database and a short Description
of the input students are allowed or encouraged to upload. Decide
if the Description should be displayed on the course page.

137

Databases

3

In the Entries slide, decide if all entries should be approved by the teacher,
if comments are allowed, if students need to submit a maximum/minimum
number of entries, and when they will be able to view other submissions.

4

In the Availability slide, decide when your database will be available for
editing and when it will be available for access without editing capabilities.
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Databases

5

In the Grade slide, you can set a passing grade for
students if this activity is to be assessed.

6

In the Ratings slide, you can set a policy on rating user entries. You can
only decide who will be able to rate entries once your database has been
created. When you are done, click on the Save and return to course button.
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Choices

1

Moodle allows teachers to ask students a multiple choice question to quickly
check something or check their opinion on a matter. Go to your course, click
on Add an activity or resource, select the Choice activitiy, and then click Add.

2

In the General slide, give a Name to your choice and a short Description
of the issue at hand. Decide if the Description should be displayed
on the course page and how the options will be displayed.
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Choices

3

In the Options slide, enter the choices students will be presented with,
decide if the can update their response, tick more than one options, and
if a limit on the number of responses per option should be imposed.

4

In the Availability slide, decide when the activity
will be available to the students.
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Choices

5

In the Results slide, decide if students will be able to see the
results of the activity and what should be displayed.

6

In the Common modules settings slide, decide if students will participate
in groups and if the choice activity should be made visible. When
you are done, click on the Save and return to course button.
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Workshops

1

Moodle allows teachers to practice peer assessment with
students’ work. Go to your course, click on Add an activity or
resource, select the Workshop activitiy, and then click Add.

2

In the General slide, give a Name to your workshop and a
short Description of what students should do. Decide if the
Description should be displayed on the course page.
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Workshops

3

In the Grading settings slide, decide on a Grading strategy and
what percentage of the students’ grade will be based on their
submission vis-à-vis their assessment comments.

4

In the Submission settings slide, you can provide instructions
on the submission to be uploaded, decide if attachments
will be allowed, and prevent late submissions.
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Workshops

5

In the Assessment settings slide, you can provide instructions
on the assessment comments to be submitted and decide if
students will be allowed to assess their own work.

6

In the Feedback slide, decide if overall feedback will be provided and
if a Conclusion text will be displayed at the end of the activity.
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Workshops

7

In the Example submissions slide, you can decide if students
will need to practice assessing some example submissions
first before assessing their peers’ submissions.

8

In the Availability slide, decide when the activity will be open for
submissions and when students will be able to asses their peers.
When you are done, click on the Save and return to course button.

146

Surveys

1

Moodle allows teachers to conduct surveys and receive feedback
from their students. Go to your course, click on Add an activity
or resource, select the Survey activitiy, and then click Add.

2

In the General slide, carefully study the Survey types that are
available and select the one that matches your needs. When you
are done, click on the Save and return to course button.

147

Blogs

1

Moodle comes with ready-made blogs for your website, your courses, and
each user individually. You can access your site blog from your Navigation
menu by following the path Navigation > Dashboard > Site pages > Site blogs.

2

To access your course blog, go to your course and follow the path Navigation
> Dashboard > Current course > My course > Participants > Course blogs.
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Blogs

3

To access your personal blog, go to your Profile
page and click on the Blog entries link.

4

To add a blog entry click on the Add a new entry link.

149

Blogs

5

In the General slide, you can give a title to your blog entry, type in
your text, add attachments, and decide who will be able to read it.

6

In the Tags slide, you can use key words to describe your blog
entry and make it easier for your website users to locate it.
When you are done, click on the Save changes button.
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Permissions

1

Moodle allows you to set specific permissions for different types of
users at different sections of your website. Create a forum and follow
the path Administration > Forum administration > Permissions.

2

Depending on context, you will see different groups of
permission settings. In this case, you can set permissions
for your course, your forum, and your activities.
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Permissions

3

Click on each capability link to get more information about it, click on
the risk icons to check the risks involved when you change something,
and permit or prohibit certain actions for certain types of users.

4

You can use the Filter text box to type in a key word that helps
you locate the capability you need to edit quickly.
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Permissions

5

Select a role from the Advanced role override dropdown menu
to edit permissions for that type of users only.

6

Editing permissions for specific roles is often faster and more
straightforward. When you are done, click on the Save changes button.
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Groups

1

Moodle allows you to create student groups for each one
of your courses. Go to your course and follow the path
Administration > Course administration > Users > Groups.

2

In the Groups tab, click on the Create group button to start a new group.
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Groups

3

In the General slide, give a name and a short description to the new group.
You can also drag and drop a picture for the group in the area provided.

4

If you set an Enrolment key students can use it to enrol on the course and
become members of the group automatically. If used, an enrolment key for the
course must be set, too. When you are done, click on the Save changes button.
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Groups

5

Now that you have created your first group, click on the Add/
remove users button to add members to the group.

6

Select the students you want to add to the group and click the Add
button. When you are done, click on the Back to groups button.
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Groups

7

To create groups automatically click on the Auto-create groups button.

8

In the General slide, type in a Naming scheme for the groups to be created,
decide if the groups to be created will be based on the number of their
members or the number of groups required, and type in that number below.
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Groups

9

10

In the Group members slide, select the type of users that should be added
to the groups, the pool from which the group members will be drawn,
how they should be drawn, and if users in groups should be ignored.

In the Grouping slide, decide if the groups to be auto-created will be added
to a new grouping. When you are done, click on the Back to groups button.

158

Groupings

1

Moodle allows you to create student groupings (collections of
groups) for each one of your courses. Go to your course and follow
the path Administration > Course administration > Users > Groups.

2

In the Groupings tab, click on the Create grouping button to start a new grouping.

159

Groupings

3

In the General slide, give a name and a short description to the new
grouping. When you are done, click on the Save changes button.

4

Once you have created a grouping, it will be listed in the Groupings tab.
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Groupings

5

To add groups to a grouping click on the group icon
next to the grouping you want to manage.

6

Select the groups you want to add to the grouping and click the Add
button. When you are done, click on the Back to groupings button.
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Group and Groupings Overview

1

Moodle allows you to have an overview of the groups and groupings
you have created for each one of your courses. Go to your course and
follow the path Administration > Course administration > Users > Groups.

2

In the Overview tab, you can see all the groups and groupings
that are available in your course as well as students that
are left out of all groups and/or groupings.
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Restricting Access

1

Moodle allows you to set conditions and restrict access to
activities or resources based on a variety of criteria. Follow the
path Administration > Site administration > Advanced features.

2

Tick the Enable conditional access checkbox to enable this feature.
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Restricting Access

3

Go back to your course and edit the settings of any activity
or resource. A slide entitled Restrict access should now
be available. Click on the Add restriction button.

4

Check out each one of the restriction options. Use them to offer different
activities or resources from the same course to different students, groups,
and/or groupings at different times, with different grades, etc.
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Cohorts

1

Moodle allows you to create groups of users called cohorts that
can be used on a system or course category level. Follow the path
Administration > Site administration > Users > Accounts > Cohorts.

2

In the Add new cohort tab, you can give a Name and a Description
to your cohort, decide what level it should be available to (system
or course categories), and make it visible to teachers.
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Cohorts

3

Once you have created a cohort, it will be listed in the System
cohorts and/or All cohorts tabs. To add users to a cohort click on
the group icon next to the cohort you want to manage.

4

Please, note the warning message displayed at the top of the page. Taking
that into account, select the users you want to add to the cohort and click
the Add button. When you are done, click on the Back to cohorts button.
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Cohorts

5

You can use cohorts to quickly enrol users on a course. Follow the path
Administration > Course administration > Users > Enrolment methods.

6

Select Cohort sync from the Add method dropdown menu.
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Cohorts

7

Select the Cohort you would like to enrol, the role its members
should have in the course, and the group they should be added
to. When you are done, click on the Save changes button.

8

The members of the selected cohort have now been enrolled on your course.
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Gradebook

1

Moodle offers you a course gradebook to help you manage
your students’ grades. Go to your course and follow the
path Administration > Course administration > Grades.

2

The Moodle gradebook offers your an overview of your students’ grades
on all of the graded activities offered in your course. You can interact with
various elements to sort by or search for the information you need to retrieve.
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Gradebook

3

If you Turn editing on, you can edit your students’ grades directly.
When you are done, click on the Save changes button.

4

You can use the dropdown menu at the top of the gradebook to generate
a variety of reports, set the weight of each activity in the course average,
and import or export your students’ grades in different formats.
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Scales

1

If you are not satisfied with the grading scales that are available,
you can create your own. Go to your gradebook and follow
the path Administration > Grade administration > Scales.

2

Click on the Add a new scale button to create a new scale.
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Scales

3

Give your scale a Name and a Description, decide if it will be
available system-wide, and define your scale values (separated by
commas). When you are done, click on the Save changes button.

4

You can delete your scale any time you like but only if
you haven’t used it to mark any of your activities.
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Badges

1

Moodle allows you to award badges to students for exceptional
achievements. Go to your course and follow the path Administration
> Course administration > Badges > Add a new badge.

2

In the Badge details slide, give your badge a Name and a
Description and upload an image to serve as a virtual badge. It
is a good idea to make the image as attractive as possible.
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Badges

3

In the Issuer details slide, fill in a name and an e-mail address. They can be
your own personal details or the school title and contact e-mail address.

4

In the Badge expiry slide, set an expiry date if the badge is unique
and can be claimed by another student later on in your course.
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Badges

5

Once you have created your badge, you need to set up the criteria
for awarding it to your students. You may award it manually, upon
completion of a course, or upon completion of an activity.

6

To be able to use the last two options, you need to enable
Completion tracking on your website. Follow the path
Administration > Site administration > Advanced features.
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Badges

7

Tick the Enable completion tracking checkbox to enable this feature.

8

Your courses and activities have a Completion tracking slide now where
you can enable this feature for each course and activity individually.
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Events

1

Moodle allows you to set events and reminders for your students. Go
to your front page and follow the path Upcoming Events > New event.

2

In the General slide, type in an Event Title and a Description, decide who
should be notified about the event, and set a date and time for it.
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Events

3

In the Duration slide, decide if you would like to set the Duration of your event.

4

In the Repeated events slide, decide if this is a repeated event.
When you are done, click on the Save changes button.
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Customizing the Front Page

1

Moodle allows you to customize the Front Page of your website to your needs.
Go to your front page and click on the move icon to move a block around. Click
on the cogwheel icon to configure the block’s setting and where it can appear.

2

You can use the Add a block dropdown menu to add
new blocks to your Front Page. Enjoy!
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Links
• Moodle
https://moodle.org/
• moodledocs: Moodle Documentation
https://docs.moodle.org/
• moodle.net: Courses & Content
https://moodle.net/
• 105 Free Moodle Video Tutorials
http://elearningindustry.com/105-free-moodle-video-tutorials
• Wide Minds: The Human Face of Digital Learning
http://www.wideminds.eu/moodle/
• Moodle
https://www.youtube.com/channel/UC_eJsmK-DMqA9Dy7bLKKL-g
• #Moodle
https://www.youtube.com/channel/UCeScp4XIxqo02Y6VcCpeFAA
• Let’s Moodle
https://www.youtube.com/channel/UChaXTlKKg0IqFYC3H32W59A
• Mary Cooch
https://www.youtube.com/channel/UCCRg_EbhU9tdpLdiGGN1Mgg
• Packt Publishing: Moodle Books & Videos
https://www.packtpub.com/all/?search=moodle
• O’Reilly Media: Moodle Books & Videos
http://search.oreilly.com/?q=moodle&x=0&y=0
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